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Einfuhrung / Hintergrund CSK

Das CADSTAR IDF Interface
ermdglicht PCB Designinformationen bi-direktional zwischen CADSTAR und MCAD
Systemen mit Hilfe des IDF (Intermediate Data Format) auszutauschen.

» CADSTAR importiert oder exportiert die IDF Versionen 2.0 und 3.0

Das IDF Format besteht aus drei Daten Files
» Board File, Library File und Panel File
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» CADSTAR exportiert das Board- und Library File
» CADSTAR importiert nur das Board File
» CADSTAR untersttzt das Panel File nicht
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Einfuhrung / Hintergrund CSK

Der IDF Link
erlaubt zwischen CADSTAR und MCAD Systemen folgende Datenobjekte auszutauschen:

» Platzierungs-, Entflechtungs- sowie Sperrflachen Type

[ IPlacement
Keapout

[#]Routing

» Leiterplattenkonturen inklusive aller Durchbriiche und
Befestigungsbohrungen

» Bauteilplatzierungen mit der Position, Rotation und der
Information auf welcher Seite von der Leiterplatte das Bauteil
platziert wird

No Routes

Mo Vias

Bauteildarstellungen:

Die 3D-Kontur wird von der Kérperumrandung abgeleitet. Die H6he
der Kontur wird vom Bauteilwert festgelegt, um das vereinfachte 3D
Model zu erstellen.

» Diese Information wird nur fur den Export verwendet.
Die vereinfachten 3D Modelle werden nichtin
CADSTAR zurtick importiert.
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Einflihrung / Hintergrund CSK

Mit IDF Daten
kann ein PCB Design in CADSTAR initialisiert werden:

» z.B. mitdem Import der Leiterplattenkontur aus der
IDF Datei in ein noch nicht platziertes PCB Design

» Der Import kann auch Flachen fur z.B. kritische Bauteile,
Sperrflachen oder Bohrungen enthalten usw.

Kontinuierliche Anderungen konnen zwischen CADSTAR

und dem MCAD System in beide Richtungen lbertragen R
werden: © O g el

| bz @/

> Anderungen der Bauteilposition, Rotation oder
Leiterplattenseite

> Anderungen der Leiterplattenkontur, Sperrflachen oder
Bohrungen usw.

Der Austausch der PCB Layout Daten zwischen CADSTAR und dem MCAD System kann
mehrfach via IDF durchgefiihrt werden. Dadurch kénnen Anderungen gezielt Uberprift
und dbernommen werden.
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Aufrufen des IDF Links

Der IDF Link verwendet das Standard CADSTAR File / Import und Export Men(

» Der IDF Link hat eine eigenstandige Lizenz

» Die IDF Option ist nicht sichtbar, wenn keine
Lizenz vorhanden ist

Das IDF Import Menu

IDF Map X
Import | Export
Design Options Component Settings Items to Import
Trport Gption Reference and P
Lnts: Othos @mm Prebalal) |IDF Package Nome. | Board Outlne
Co-ordinate ¥ Shift: | 0,000 | ey Component Placement
= i Hole Settings
Co-ordinate ¥ shit: | 0.000 | (e = [ Placement Keep-out Areas

Mounting Hole Frefix; parthole

[ 1mport co-ordinates relative to Design Grigin [[IPlacement Areas
Mounting Hole
Component Name | MH

[ routing Keep-out Areas
Stem{RefDes):

[#] Delete Existing Unfixed Areas and Outlines

[JReouting Areas
Impark Hole Az

COther Outlines

Mourking Hole If [[]¥ia Keep-out Areas

| (o)

Tap Layer: Larger Than:
| i [ other Outlines
Cut-out I Larger
Than: ot}

| Bottom Layer: [[] Mounting Holes

Character Mapping

ok | [ concel ][ relp
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Export To File E

Export To File E

Output File

C:ADocuments . AStartDesignl.emn

Browse. ..

Format: | IDF [v

CADIF
CADSTAR Part Library

DF
fchive
Saurce | PREditor <R Files
PREditor 4R HS / 51 Yerify Files
RIMF Netlist

Output File

C:\Documents .. \StatDesignl.emn

Browse...

Format: | IDF

™

Source Yariant

Mapping File

Erowse

Create Map,

4 apping File

C:ADocuments and Setti. ADF1.map

Create Map...

] [ Cancel ] [ Help ]

Das IDF Export Menu

IDF Map
| Import | Export |
File Farmat Carpanert: Setings
Export Units: @thou  Owm Outline Layer:
IDF Version: |version 3.0 [w] Height
Library File T | [[]Use Height Defi
Extension: Leme 2|
Design Cptions
Co-ordinate % shift: | p,000 (Thou)
Default Height:
Co-ordinate ¥ Shift: | 0,000 (Thou}
[l output Zero Hei

[#lExport co-ordinates relative to Design Origin
Board Thickness
Defined by Layer Stack 64,370 {Thou)

| [CJowerride Layer Stack Thickness

Other Outlines Hole: Settings
2] Mounting Hole

= Component Mame
I

Top Layer:

Bottom Layer: Stem (RefDes)

ined by Attribute

Use Height Defined in the PCB Companent

0.000

ight Components

IDF Package Mame: | peference(lternate) | v Holes

IPart Name

| MH

Thems ko Export

[“]Board outline

Component Placement
[CIPlacement Keep-out Areas
[Irlacement Areas
[Jrouting Kzep-out Areas
(Thow [routing Areas

[]ia Keep-out Areas

[ Other Outlines

[¥ia Holes

[CJcomponent Holes

[CIMounting Holes

Character Mapping

Defire Mappin

[_ok ][ cancel J[ tep




IDF Import - Objekte a

Verwenden Sie die Kontrollkastchen in den "ltems to Import”, um den
Abschnitt auszuwahlen aus dem die Datenelemente via IDF importiert

Items to Imnpork

werden sollen: [ oard Outie
Component Placement
» Wabhlen Sie flr den Import nur die Daten die Sie bendtigen BEkomen e ot o
[]Placement Areas
Geschitzte Design Objekte: [JRauting Keep-out Areas
|:| Routing Areas
> Alle Objekte die im CADSTAR den Status ,FIX“ haben, werden durch den Ak i
IDF Import nicht verandert. Das betrifft z.B. Bauteile, Flachen und el
BOh ru ngen . [CIMounting Holes

Import Option Units:

>  Betrifft nur die Werte hier im Dialog Pesion oo comenenReeE B
RO Ormn Reforenceond i packageiame_[w]
» flur die Befestigungsbohrungen gelten T hod) |
Hole Settings
besondere Regeln Co-ordinate ¥ Shift: | 5a05,512 (Thou) ; :
Mounting Hole Prefix: Hole
» Die Einheiten fir die Koordinaten-daten [#tmpert co-arcinates relative to Desin Orign T
Werden der IDF'Datel entnommen [#] Delete Existing Unfixed Areas and Outlines g&ﬁﬁgﬁfme e
> Bei Bedarf werden die IDF Daten in die I ‘”":”T"'Tj - -
. . . [ ounking Hole ai
aktuellen CADSTAR Design-Einheiten Top Layer | v Larger Than: 12250 b
umgewandelt B e : ; %‘;ﬁ“k IFLarger | 5oc oy | (Thou)
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IDF Import - Objekte Video CSK

M - Workspace_Express_Design_IDF_V1 - Start Page - Zuken CADSTAR Design Editor -

Home Library Tools View Pl 7

b @ Record | &—?

Il Wait
Execute = User
;s 4 Cuit Tools =
Macro User
| -~
-Q - H - .
:| M CADSTAR Design Editor 16.0
=
&
E- - ]
= Recent Workspace Files OnLine CADSTAR News Reader
: (=] DACSK_Data\Demo' My Expr. Workspace Express Design IDF_W1.csw ; e
?' DACSK_Data'\Demo\CADSTAR_.. \Workspace-CADSTAR-HS-Training_V1.csw
E (=] DACSK_Data'Demo\CADSTAR . Workspace-CADSTAR-HS-Training_V1.csw
g D VCSK._Data\D.. \Workspace Express Design_CS16_RainMaker 7 V1.csw
E 8] 5201 B\Ruhnke\CB\RuhnkeJob\Workspace csw
= Open Workspace... Save New Workspace.., The CAD STAR 16.0 Web Release i Is available for
3 download!
g The Web Release for CADSTAR 16.0 has been released and is no
= i i for download.
% Recent DEEIQH FIIEE Some of the enhancements included in the CADSTAR 16.0 release
tn s - ! : : Activ-45 Move and Re-lengthening enhancements, Increased flexib
M D \CSK_Data\Demo\__My_ExpressiDF-Interface\DesignsiTutorial pcb e, Ahilly 1o modite s wilhin & troap and e feasme ts o
™ D\CSK_Data\Demo\ My Express\DF-InterfaceVDF.. \Tutorial_3.pch to-add a connecion. v
Ml - .~ e = 8 .. . .- TR aien g . - lirk hara far rara dataile amcincliidad faatiarae Ar
< >
4 M statrage E b

Overlapping Connections R x|
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IDF Import - Design Options CSK

Ermdglicht ein Koordinaten Offset fur alle IDF Daten wahrend des Imports:

Design Options
» Damit werden die Differenzen von unterschiedlichen Inpert Sntian

) ; OTh ®
Nullpunkten zwischen CADSTAR und dem MCAD Units: T i
System ausgeglichen Co-ordinate X Shift: | 0,000 (mm)
» Diese Werte werden mit dem CADSTAR interaktiven Co-ordinate Y Shift: | 0.000 {mm)
Nullpunkt kombiniert Import co-ordinates relative to Design Origin

Delete Existing Unfixed Areas and Outlines

Das Loschen von nicht fixierten Flachen und Linienkonturen, die nicht in
dem IDF vorhanden sind muss explizit gewahlt werden:

> Gibt einen zusatzlichen Schutz gegen das Verlieren und die Anderung
der bestehenden Konstruktionsdaten
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IDF Import - Component Settings CSK

Das Referenzieren von Bauteilen im Design:
> Basierend auf den Bauteilnamen

Component Settings

Reference and [aa)
e . . . (Alternate) IDF Package Name v
» Position, Rotation und Seite werden mit den TOF Package Name
IDF Daten aktualisiert IDF Part Number N

Hinzufligen von fehlenden Bauteilen zum Design:

» Die erforderliche Referenz zwischen der CADSTAR Bibliothek und den Bauteildaten im IDF File
ist herzustellen.

Die Inhalte der Referenzenfelder kénnen unterschiedlich zugewiesen werden.
Da die MCAD Systeme die Inhalte der Referenzfelder unterschiedlich verwenden.

Field, Description Type Value

1 || Package name string Any Part name for package geometry

2 ||Part number string Any Component part number

3 | Reference designator string Any Electrical component instance reference

designator

MOREFDES  Indicates that component instance is a
mechanical component

BOARD Indicates that instance is a board on a
panel

www.cskl.de 9



Video - Bauteile Platzierung via IDF

| (REET dh &5 H 3  [E3 = Workspace Express Design IDF_ V1 - Tutosial-3.peb [DACSK_DatahDemet My Ecpressh|DF-Interface: Desig...
ﬁ Haome Component Mt S Shape Design Library Report Tl hanufatere WView & ‘_:l'
i @ Record =1 O=s0 ; | - . B, seviser e
L I '-I-i g - | “ l'-{ : “i
H—p ——— X _. adviser [etall
Execute Embedded Auto PREditor PREditar Board Fieid Lizer
b -l Pouter  XR ¥F. HS Modala Sohver Toals =
BAALTO Embedar: REddtor . (=14 Held Sehvar EMIC Bowmser Liser

1 M sanrage B wwnasps B P
Owerlapping Connedians « 0 B3
Conveding deskgn DeVOSE_Dats\Dema’ My ExpreifDF-InlerfaceiDesignatTul arizl-3.peh -1373.5 1084.8 Thou  Grid: 5.0
PE L —
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IDF Import - Component Settings CSK

Das Verfahren wie ein neuer Part in dem Design hinzugeflgt wird:

» Durch Kopieren eines existierenden Parts aus dem Design

» Durch Hinzufligen eines neuen Parts aus der Bibliothek

Falls dieses Vorgehen erfolglos ist, wird versucht
nur das Footprint gemafd IDF Bezeichnung hinzuzufligen:

» Durch Kopieren eines existierenden Footprints aus dem Design

» Durch Hinzufligen eines neuen Footprints aus der Bibliothek

Im zweiten Fall ist dem Footprint kein Part zugewiesen. Der Bauteilname (Ref Des) fir
neu hinzugefiigte Bauteile, wird durch die Bezeichnung in den IDF Daten bestimmt.
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IDF Import - Mounting Hole Settings CSK

Befestigungsldcher konnen als “Einzel-Pin"-Bauteil oder als Hole Settings
Loch in die Leiterplattenkontur importiert werden: Mounting Hole Prefix:| Hole]
» Die Grol3e vom Loch entspricht dem Bohrungsdurchmesser Mounting Hole
Component Name MH
Stem(RefDes):
Befestigungslocher werden durch Bauteile représentiert: ‘"‘;‘:”g:w
i i ; {mnm)
> Name (Ref Des) im IDF File Larger Than:
» Bedingung: der Bauteilname Prafix wird wahrend des Imports St ot L arger (mm)

passend definiert
> z.B.: MH1, MH2, MH3 etc.

Befestigungsldcher kdénnen nach Ihrem Typ in der IDF-Datei identifiziert werden.
» ‘MTG’ oder ‘TOOL

Bohrlocher in den IDF Daten werden als “Einzel-Pin” Bauteil in CADSTAR eingefligt.

Wahrend des IDF-Imports kénnen vorhandene Locher verschoben, verandert oder
geléscht werden.
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Video Import Bohrungen und Durchbriiche C&

| b vl Ah &5 # 3  [ED = Werkspace Express_ Design IDF V1 - Tutosal.pch [TRCSE DatahDeme’_Wy_ExpresshIDF-Interface’ Designs...
ﬁ Hame Companent ket / Shape Design Library Report T ils MEanufadure Wi £ ‘_:l'
i & Record =3 O=io ; | s . B, sdviser e
L | '-I-i e | | “ l'-{ : i
P ———— X _. Sdviser Detall
Execute Embedded  Auto PREdior PFREditar Eoard Fiaid Lser
b -t Pouter iR 1P HS Fodele Sohver Toals *
MALTO Embeddee REddtor . (=1 Held Sehar EMIC Bowser Lizer

1 M setrage B tonapn 3 p
Owerlapping Connedtions « 0 B3
wWriling design Cubserst KLLWWET - 1. OS50 A ppDataiL oAl Temp' ZRALEL tmp 306.6 217.8 Thou  Grd: 5:.0
— —
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IDF Import - Other Outline Einstellungen C&(¢

Wird verwendet, um Datenobjekte zwischen den ECAD / MCAD auszutauschen,
fur die es in beiden Systemen oder im IDF Format keine Entsprechungen gibt.

» Zum Beispiel Kuhlkorper, besondere Arten von Flachen, Langlocher usw.

Other Quthnes

Top Layer: Mechanical Drawing

Bottom Layer:

Die Darstellung und Interpretation der Daten wird durch den Anwender festgelegt.

Die Daten werden als geschlossene Kontur auf einer festgelegten Lage importiert.

» Die Konturen kdnnen Ausbriiche beinhalten vzﬁHVA:ND‘
— A A=A

» Die Konturen werden auf den zugewiesenen
Lagen oben oder unten in CADSTAR platziert
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Via Outer Outline Import CSY

| (RET dh &% HL 3 = [F] 5 Workspace Express_Design_IDF N1 - Tutosial-S.pch [DCSK_Datah\Demc' My Express\IDF-Interface’ Cesig...
ﬁ Haene Compaonent M=l Shape Dasign Library Report Tools hanufadure Wiaw & i:_l"
& Recard =] O=s = - E'q;_ Aeluizer e
I '-I-i s |5 \ “ f-{ i
. ey e . _; Adviser Detail
Execute Embedded Auta PREditor PREditar Board Fiald Liser
b Uit Powter iR XF. HE Fodaler Solhver Toals *
sMadro Embedden ‘REtor (=114] Held Sohar EMIL Bwser Liser

(8]}

"L

[

LIEL |..,'_-

subiisiag

1 M satrage | ™ Tutonalspco B3 I
Deflapping Connedions « 0 B
Ready T33.6 358.0 ThHou  Grid: 50
-— —=X
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Via IDF eine geanderte Leiterplatten
Kontur einlesen D R

M b | = ke Jh 4% WL @ @ [F] 5 Workspace Express Design [DF V1 - Tutosal-6.pch (08 C5K_DatahDeme’ My Epresst|DF-Interfaceh Desig...
ﬁ Hiome Compaonent ket fShape Dezign Library Report Tools hEanufaciure Wiew & L
& Record =3 e = . . (" m;_ Acluiser e
ok ey L. . .; &dviser Detall
Execute Embedded  auto PREditor PREditor Board Fieid ; Liser
T 4 Lt Router %R ¥ HS Mo dele Solver Toals «
MdacTa Embiecdden ‘REdHtor Eki Field Sohear EMC Adwsef Liger

< >
4 M saneage ¥ Tuwosaspcn B P
Owerlapping Connedians « 0 B
wWiriting dcsig:. i Userst KLLWVET ~ 1. CS80 A ppDatlayLocalTemp ZRSFEA Imp 3526 509.4 Thou  Grid: S.I}_ = Sty
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IDF Export - Optionen

IDF Map Dialog — Export Tab :

www.cskl.de

IDF Map

[ Trmport |_E><|:":rt |

File: Format
Expart LUnits: @ Thou  Cimm
IDF Mersion: E\p'er'siljn 3.0 | v]
ol e [l
Design Options
Cao-ordinate ¥ Shift; EID,UDU {Thou)
Ca-ordinate ¥ Shift: | 0.000 {Thou}

Export co-ordinates relative to Design Origin
~Board Thickness -
Defined by Laver Stack 64,5370 (Thou)
[Towerride Laver stack Thickness

Thickness: |1

| (Thaw)

Okher Qutlines

Top Layer: | | ﬂ

Bokkom Layer: | | V]

Component Settings

Cutline Layer: Top Assembly | Y]

Height

[Juse Height Defined by Attribute

Use Height Defined in the PCB Component

Defaul Height: | 0.000 | (Thow

Cutput Zero Height Components

IDF Package Mame: |ReFerence(nlternate) ivl

SEbribute

Mame:

IDF Part Mumber: |Part Marne |i]

“Hole Settings

Mounking Hole ;
Camponent Mame | MH
Stem (RefDes) T

Items to Expork
Board Sutling
Caormpaonent Placerment
Placement keep-out Areas
Placement Areas
Routing Keep-out Areas
Routing Areas
Via keep-out Areas

[Jother outlines

Huoles

‘ia Holes
Camponent Hales

Maounting Haoles

Character Mapping

Define Mapping ...

Ok J[ Cancel ][ Help
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IDF Export - Varianten und Objekte

IDF Export — Varianten :

» Wenn ein Design Varianten enthéalt, wird immer die aktuelle
Variante exportiert

» Nicht bestlickte Bauteile (Not Fitted) werden nicht mit exportiert

IDF Export — Objekte :

» In dieser Auswahl legen Sie fest, welche CADSTAR Objekte
via IDF Export ausgegeben werden sollen

» Locher in der Leiterplatte werden unterschieden in Vias,
Bauteilpins und Befestigungsldcher

www.cskl.de 18

Export To File

Dutput File

C:ADocument.. \OriginalDesignl . dwf

Ikems bo Export
Board Outline
Component Placement
Placement Keep-out Areas
Placement &reas
Routing keep-out Areas
Routing Areas
Via Keep-out Areas

[ other outlines

Hioles

Wia Holes
Zomponent Holes

Mounting Holes




IDF Export - File Format Einstellungen

K

Hier wird fur die Erstellung des Datenexports die Ausgabeeinheit

auf ,Thou“ oder ,mm* festgelegt. Das qilt fiir alle Zahlenwerte
innerhalb dieser Maske.

Die Ausgaben erfolgen in der IDF Version 2.0 oder 3.0:
» Je nach MCAD System konnen die File Extensions
-emp -pro -lib -Idf gewéahit werden.

Ermoglicht ein Offset der Koordinaten fir alle IDF Daten wahrend

des Imports:

» Damit werden die Differenzen von unterschiedlichen Nullpunkten
zwischen CADSTAR und dem MCAD System ausgeglichen

» Diese Werte werden mit dem CADSTAR interaktiven Nullpunkt
kombiniert

Die Leiterplattendicke wird aus dem CADSTAR Layer Dialog

entnommen, alternativ kann hier ein anderer Wert eingegeben
werden.

www.cskl.de 19

File Format
Export Units: @Thou  Omm
IDF Yersion: E-‘\;'.er-s.ilon 30 v!
Library File I s |
Extension: ] )

Design Options

Co-ordinate ¥ Shift: | 1000000 {Thou)

Co-ordinate ¥ Shift: | so0.000 (Thou}

[¥]Export co-ordinates relative ta Design Origin

EBioard Thickness

Defined by Layver Stack 64,370 (Thou)

Override Laver Stack Thickness

Thickness: | 63 | (Thou

Component Setkings

| Top Assembly | 8 E

Outline Layer:
Height

[Juse Height Defined by Attribute

Use Height Defined in the PCE Compaonent

I Default Height: :D.EIEID (Thau}) l

Qukput Zero Height Components

IDF Package Mame: ;Reference(nlternate) 'Vs

IDF Part Mumber: E-ba"t Marne :i



IDF Export - Component Settings CSK

Das Auswabhlfeld “Outline Layer”
bestimmt die Lage der Kontur von welcher die Form der Bauteile abgeleitet wird:

Componenk Sethings

Qutline Laver: Top Assembly |l|

Height

[[JUse Height: Defined by attribute

Helght
Attribute:

Use Height Defined in the PCE Component:
Default Height: IIJD_DD ! (Thaou})

Qukput Zero Height Components

IDF Package Mame: |Reference(.ﬂ.lternate) |ﬂ

Aktribute '-._:-_3]-. 18
Marmie! ;
IDF Part Murber: |
|Part Mame | il

Attribute [alue
Mame e

» Legt die Form des Bauteils fest
» Muss eine geschlossene Kontur sein
» Wird ebenfalls fir die gegenliberliegende Leitplattenseite verwendet

Die Informationen bzgl. der Bauteilhbhen werden zur einfachen 3D-Darstellung verwendet.
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IDF Export - Bauteilhohen CSK

Der Abschnitt “H6he” gibt an, von wo die Informationen i

bzgl. der BauteilhOhen aus dem Design genommen

. Height :
werden: Hedt Height

Use Height Defined by Attribute

» Als ein Attribut aus der Parts Bibliothek [“] use Height Defined in the PCB Component
Attribut Typ: Component oder Part Definition

» Aus der H6heninformation vom Bauteil

Default Height: 250.000 {Thou)

Output Zero Height Components

Sind beide Optionen gewahlt, gilt folgende Reihenfolge:
> Attribut
» Hoheninformation vom Bauteil

Der ‘Default Height” Wert wird fur die Bauteile ohne
der obigen Hoheninformation verwendet.

Die Ausgabe von Bauteilen mit einer ,NULL" HOhe lassen sich gesondert steuern.
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IDF Export - Component Settings "CW

IDF Package Name und IDF Part Number:

> Erlaubt die Kontrolle welche CADSTAR Namen in den IDF Daten
genutzt werden

» Dient dazu, unterschiedliche MCAD Systemanforderungen zu
erfullen

IDF Package Name: |Reference(flternate) ™

IDF Part Number: | part Name [l

Ermdglicht die Anpassung zwischen ECAD- und MCAD-

ICF Package Name: Referencelalternate)

B I blIOthekS n am en . EeFEa;uence(Alternate)
Folgende Auswahl steht zur Verfiigung: (o port mbers | defned Atrte
> Referenz & Alternate —

» Part Name
» Part Number
» Benutzerdefiniertes Attribut

IDF Package Mame: ||ser-defined Attribute

kkribute 3DModelMarne
Mame:

IDF Part Mumber:  |part Mumber

Ermdglicht dem Anwender festzulegen, welche Einzel-Pin
Bauteile in der Konstruktion als Montagel6cher verwendet
werden, z.B: MH1, MH2, MH3 usw.

» Damit diese Bohrlocher in der IDF Datei als Montagebohrungen Hole Settings
identifiziert werden Mounting Hole:

> Eine Ausgabe als Bauteil erfolgt fiir die Bohrlécher somit nicht S e
mehr

» Die Bezeichnung des Montagelochs (Ref Des) wird im IDF in
Zusammenhang mit der Metallisierung verwaltet
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IDF Export - Other Outline Einstellungen C&(¢

Wird verwendet, um Datenobjekte zwischen den Other Outlines

ECAD / MCAD Systemen auszutauschen, fur Top Layer: Mechanical Drawing
die es in beiden Systemen oder im IDF Format

keine Entsprechungen gibt. Sotiom Layer;

» Zum Beispiel: Kuhlkorper, besondere Arten von Flachen, Langlécher usw.

» Die Darstellung und Interpretation der Daten wird durch den Anwender festgelegt

» Die Daten werden als geschlossene Kontur auf einer festgelegten Lage importiert

» Die Konturen kdnnen Ausbrtiche beinhalten

>

Die Konturen werden auf den zugewiesenen Lagen oben oder unten in CADSTAR platziert

VEETV-AGIND

z.B. kbnnen damit Langlécher (slotted holes)
als geschlossene Kontur mit der korrekten
GroRe und Position eingezeichnet werden.
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IDF Charakterumsetzung in Namen CSK

Erlaubt eine Zeichenumsetzung zwischen gultigen CADSTAR Zeichen und den
verschiedenen MCAD Systemen:
» Diese Zeichenubersetzung gilt gleichzeitig flr den Export und Import von IDF Dateien
» Das gilt fir Bauteil-Referenzen, Alternativen und Part Namen
» Als ,Escape Character” wird das Startzeichen fur die Umsetzung bezeichnet

IDF Character Mapping E —
_ Original Replacement
Character Mapping G RLEIE . ASCII Character ASCII Character
Escape Character: - _v_ 3 2 space 48 0
[_Defineﬂlapping". Characters ko map: | #()@| 33 | 49 1
Tottacf st bt 34 " 50 2
35 # 51 3
[ OK H Cancel ][ Help 36 $ 52 4
37 % 53 5
38 ! 54 6
) ) .. 39 ( 55 7
Jedes Sonderzeichen hat ein vordefiniertes m ) C P
Ersetzungszeichen. 41 * 57 J
42 ) 65 A
43 - 66 B
z.B. wird der Name: ABC+123(RE-FLOW) j: - :; ;
umgesetzt in: ABC-9123-7RE-BFLOW-8 76 , 5 -
47 ; 70 F
58 < 71 G
Name Illegal Characters 22 = ;g T
Reference(Alternate) [*? O {3[1<>~&] = (; o J
) ~&|1#$'+, = A "
Part Name 2O <>~&[#$'+,:;=@)\ 62 \ 75 K
63 A 76 L
64 B 77 M
91 ) 78 N
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Einstellungen flir den Import BML

CADSTAR BML

kann IDF Daten importieren, manipulieren und wieder exportieren.

Import  Export

Fie Format.

Export Linits: @thou  Omm

IDF Version: Version 3.0 ~
Library File

Extension: i hd

Design Gptions

Co-ordinate X shift: (thou)
Co-ordnate ¥ shift: (Thou
Expart co-ordinates relative to Design Orign
1 Board Thickness
Defined by Layer Stack 64.370 (Thou)
[Joverride Layer Stack Thidness

Thickness: [ 0.0 (Thauy

'Other Cutines
Top Layer: Top Assembly v

Bottom Layer Bottom Assembly ~

Component Settings
Qutiine Layer: -
Height
[use Height Defined by Attribute

Height
Attribute:

Use Height Defined in the PCE Component
oefatreant o
Output Zero Height Components.
[[] Use Height as part of component name
Package Name/Part Number
IDF Package Name: | Reference(Alternate)

attribute
IDF PartNumber: e »
Attribute

[ use Reference(Alternate) if blank
[ suppress blank alternate name

Hole Settings
Mounting Hole Component Name Stem (RefDes):

Items to Export
|Board Cutiine

Component Placement

Piacement Keep-out Areas

Placement Areas

Routing Keep-out Areas

Routing Areas

Via Keep-out Areas

Other Outines
Holes

Viz Holes
ampanent Holes
Mounting Holes

Character Mapping
Mapping Style
(® Reversble Mapping
Define Mapping ...
O Legacy Mapping

[Replace Spaces with
Underscores

L

3 Abbrechen

x|

Froject Browser b I
fssembly | Library EDA LF | IDF IF |

Category : IOonversion Parameters LI

— 20 to 30 conversion

[+ Precede laver color

E-side parts inv. axis : m
Minimum hole size : IU.UUD thau
—Simple part shape eeneration

Secondary laver : IW

Primary layer :

Project Browser

Assembly |Lihrary| D, 4| ¥

q

ﬁ Garry-1
-] Assembly
{21 _Document

Hierzu sind nur die jeweiligen Lagen entsprechend anzugeben.

www.cskl.de

X Control Panel 1
Layers |Parts | Mechanical parts' Nets | WCS |
Rendering of parts: |Default _.

Yiew | Layer Type Side | Ci

Project Browser 2
Assembly | Library | EDA I/F IDF /P |

IDF Sections

Categary

IDF section | Side | Hook |

Layer name

Profile of parts__ | TOP ¢ Top Assembly

Profile of parts BOT
Mechanical Hole | ALL
Lead Hole ALL
Wia Haole ALL
BOARD_QUTLIME | ALL
OTHER_OUTLIME | TOP
OTHER_OUTLINE | BOT
ROUTE_CUTLINE | TOP
ROUTE OUTLIME | BOT
ROUTE_ OUTLIME | ETH
ROUTE OUTLINE |IN

ROUTE_OUTLIME | ALL
PLAGE OUTLINE |TOP
PLAGE OUTLINE | BOT
FLAGEQUTLIME |BTH
ROUTE_KEEFOUT| TOP
ROUTE_KEEPOUT| BOT
ROUTE_KEEPOUT| BTH
ROUTE_KEEPOUT|IM

ROUTE_KEEFOUT| ALL
WIA_KEEFOUT ALL
FLAGE_KEEFOUT | TOP
PLAGE_KEEPOUT | BOT
PLAGE_KEEPOUT | BTH
PLAGE_REGION | TOP
FLAGE_REGIOM |BOT
FLAGE_REGIOM |BTH

Eottom Assembly

Top Assembly
Eottam Assembly

[e]=[~[=]=[-]=[<[+

=

>

=

Top Placement

|‘.|

El

Bottom Placement

=

v

=

=

5
=

[

e
e

e
&

r
=

ra
&

5
=

Top Eles_PLAGEMENT
Eottom Elec_PLAGEMENT

[
p)

YU UK

e
&

+ Top Assembly
Bottom Assembly

Hole

Keep-injout ELEC1-ToP [
Keep-infout ELEC4-BOTTOM .
Board Layer irrelevant .

L

2] o

' »| ~ [BoaRD_FIGURE
| 4] ™

Hole Transparent
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Video IDF Export und BML IDF Import
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Video CADSTAR <-> BML CSY

| (RET dh &% HL 3 = [F] 5 Workspace Express_Design_IDF N1 - Tutosial-G.pch [DCSK Datah\Demc'_ My_Express\IDF-Interface’ Cesig...
ﬁ Hiene Compornent et/ Shape Diazign Library Report Toils Panufaoera Wiaw & i:_l"
& Recard =] 0=y = - E-q;_,.!.,d.,-i“r P e
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CSK- CAD Systeme Kluwetasch

Struckbrook 49
D- 24161 Altenholz

r'f'__| _f’k ; | _x
- ud - W N
Tel. + 49 (0) - 431- 32917- 0 S B

Fax. + 49 (0) - 431- 32917- 26

Email: kluwetasch@cskl.de

Web: www.cskl.de

Vielen Dank fir Ihre Aufmerksamkeit.

Karl- Heinz Kluwetasch
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